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Revision History

Ashish Upreti 06/21/2023 First Version
Michele Baughan
0.2 Ashish Upreti 07/12/2023 *  Updated Pg. 6, added information regarding updating provider

and member’s auto populated information.
*  Updated screenshots (Page 10 & 16).
*  Added additional information in:
*  Page 10 — Reporting Party — Notes (B)
* Page 16 — Medicaid Member — Notes (C)

0.3 Ashish Upreti 08/10/2023 Pg 10 - Reporting Party - Updated screenshot and info in

notes section to accommodate latest changes.

¢ Pg 16 - Medicaid Member - Updated screenshot and
information to accommodate latest changes.

*  Pg 2l - Incident Description - Updated information for "Date
and Time Incident Occurred" field

*  Pg 26 - Incident Type - Law Enforcement Intervention -

Updated information in Step 2.
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Revision History

Ashish Upreti 10/16/2023 *  Provider Responsible for Member (Pg. 16) — Updated
application screenshot and add wording to reflect new changes
regarding “Advanced Search”

*  Provider Responsible — Advanced Search Feature (Pg. |7) —
Added new slide on how to use advanced search feature.

* Incident Type (Pg 25 to 31) —Screenshot and an additional step
has been added to reflect new question added to each incident
type.

*  Existing Incident (Pg. 53) — Updated screenshot to reflect latest
changes along with changes in Legend.

0.5 Ashish Upreti 01/19/2024 * In Medicaid Member > Service Program (Pg.19) — Replaced
“Other (Non-waiver)” with “TCM (Non-Waiver)”.
*  Added additional details in Pg.19 description.

0.6 Ashish Upreti 04/28/2025 *  Other reports section has been removed, fields have been
Michele Baughan moved under incident types law enforcement and abuse report.
*  Added instructions for two new incident types,“Use of a
Restraint” and “Medical Treatment”. Pg 32 and 33.
*  Correction functionality sections added pg. 40-50.
*  Existing incident details have been updated with latest changes.
(Pg.53)
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IMPA Registration & Application Access

B [f you do not already have access to IMPA, please register here: IMPA (state.ia.us)
" Iowa Medicaid &
Portal Access| Wi 4

Register New Account Documents

B For access to the Ciritical Incident Application, please complete this form and submit.
Registration Form Link: https://www.tfaforms.com/243237

B Once you have an account and access to the application, follow these steps to report
a new incident or to access existing incident.

® Sign into IMPA. IMPA (state.ia.us)

® To create a new incident report: In the navigation bar, go to Files > Ciritical
Incident Report

File» Review» Manage » Information» Messages Logout

Claim PIN
Critical Incident Report|

® To access an existing incident report: In the navigation bar, go to Review >Existing
Incident

File» Review)» Manage» Information» Messages Logout

Existing Incident|
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Critical Incident Reporting
Application

The Ciritical Incident Reporting Application is designed as a central location for reporting and
storing critical incident reports for lowa Medicaid members enrolled for HCBS Waiver,

Habilitation, or other designated programs.
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Things to keep in mind

Throughout the application, an * indicates the fields/sections that are required.

The “|” character is not allowed in the CIR form. It cannot be typed or pasted.

At the end of each section/page there will be save and clear buttons available.

Some sections consist of steps that needs to be followed. Steps are outlined. E.g., Step |, Step 2.

If (ou’ve aIreacIIEy filled out an incident but due to some reason were not able to submit or complete
it. Please go to “Existing Incident” page to access it.

B  The maximum character limit on some free text fields is 10000 characters. If additional supporting
information needs to be included, please use the “Additional Follow-up and Notes” section or attach
the supporting documents using the “Upload Supporting Documents” function. Reference the
location of the additional supporting information in the free text field.

B To change any auto-populated read only fields in the form, use the following methods.
®  Provider’s information:
* You will need to use this form to correct any of your organization’s data:
470-4608 lowa Medicaid Provider Address Change Request
m  Member’s information:
* If you need to change member's address, please contact |1-877-347-5678.

m Support:

m  For issues while navigating the application please contact impahelpdesk@dhs.state.ia.us. For
issues with user registration, account, or password problems, please contact
impasupport@dhs.state.ia.us

m  For Application Access: Please click here IMPA Registration Link
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https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fhhs.iowa.gov%2Fsites%2Fdefault%2Ffiles%2F470-4608.pdf&data=05%7C01%7Caupreti%40dhs.state.ia.us%7Ceff14a28ce2c427ffd8208db8152a9c4%7C8d2c7b4d085a4617853638a76d19b0da%7C1%7C0%7C638245964263457466%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=68k6CR6lvrlTfRoBbTr6HjCdilk4LJM6R0dpe5kmgTg%3D&reserved=0
mailto:impahelpdesk@dhs.state.ia.us
mailto:impasupport@dhs.state.ia.us
https://secureappt.dhs.state.ia.us/impa/Assets/IMPAUserRegistration.pdf

Navigation Sidebar

[ T, [ N W R L% I

|

9

10

NilCid MTISS

Provider Responsible for Member*
Medicaid Member*

Case Manager*®

Location of Incident*

Incident Description®

Incident Types

Complete at least one section and select primary™
Physical Injury

Medication Error

Emergency Mental Health Treatment
Law Enforcement Intervention
Abuse Report

Location Unknown

Death

Use of a Restraint

Medical Treatment

Resolution
Immediate Resolution™®

Motifications

Cancel Intial Submission

Reporting Party™ o

________________________________________________________________

The navigation side bar is divided into three
sections.

m [nitial Submission
® Final Submission
m Additional Information Section

To be counted as a submitted incident
report, the user must complete sections 1
through 9 and select “Initial Submission” in
section 10.

To ensure timely reporting, the reporting
party must complete sections 1 through 9
and select “Initial Submission” in section 10
by the end of the next calendar day after
discovery of the incident

Important Note: Sections 1 through 9
cannot be edited after submission unless
correction is issued.

IOWA

HHS



Navigation Sidebar (on

11 Remediations
Complete at least one section™

Long-Term Remediation and Resolution
Staffing-Related Remediation
Member-Related Remediation
Equipment and Supplies Remediation
Environment Remediation

Systemic Remediation

12 Final Submission

Additional Information Section
Additional Follow-up and Notes
Upload Supporting Documents

B Section 11 “Remediation” is for documenting the
long-term remediation efforts that have been or
will be done to address the incident and prevent
future, similar incidents from occurring. Section 11
should be completed within 15 calendar days after
the incident was submitted.

. @ To complete the incident, the reporting party must |
! complete Section 11 and select “Final Submission” !
in Section 12.

B [Important Note: The incident report is considered
complete and resolved once the “Final Submission”
is selected in Section 12. The incident report, aside
from the sections noted below, cannot be edited
after it has been finished/completed unless
correction is issued

, @ Additional Follow-up and Notes and Upload
Supporting Documents will remain fillable and :
accessible for all incident reports in progress and
! completed.

Corrections
B Corrections is allowed once “Initial Submission”
and/or “Final Submission” is made.
IOWA
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Completing the Incident Report Sections

_______________________________________________________________________________________________________________________

. Upon creation of new incident report, the status of the incident report is “Initial
: Submission”.
' Report Date: This field defaults to the date the incident report was created in IMPA. The

date can be edited up until Section 3: Medicaid Member is completed and saved. At that
. point, it becomes locked and no further edits to the report date can be made.

Incident Status: Initial Submission *Report Date: 04/07/2025 = «
Incident ID: 42822 Version Mo: 2.0
Medicaid State ID (D Member Name: (D
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Section |: Reporting Party

______________________________________

Step 1: Reporter must enter the
NPI associated of their

Step I: Reporting Party organization and hit search.

Step 2: The organization’s name
and contact information will auto-
populate based on the NPI
entered in Step 1. The
reporter/user will not be able to
edit any fields in this section.

Search Critera

“National Provider Identifier (NPI}): : Search

Step 2: Naticnal Provider Identifier {NPI)

Organization (Name or Agency)

Notes:

|AMERIGROUP IowWa

o
o

r information serves to validate reporting party details. Displayed contact detail
[ ent. For address inaccuracies, use Change Address option. It'

e
ontact Information takes precedence over Reporting Party

wn

for the information in Step 2
to populate correctly.

Organization’s contact information: ~ Change Address

Address Line 1

B. The reporter/user will not be
[4800 WESTOWN PKWY STE 400 |

able to edit any fields in this

Address Line 2

| | section.
City State Zip . .
[WEST DES MOINES -[0000 | C. Organization address can be

changed using form 470-4608.
This form link is also provided
when user presses “Change
Address” button in the application

______________________________________

I A.  Step 1 must be completed

IOWA

HHS ..


https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fhhs.iowa.gov%2Fsites%2Fdefault%2Ffiles%2F470-4608.pdf&data=05%7C01%7Caupreti%40dhs.state.ia.us%7Ceff14a28ce2c427ffd8208db8152a9c4%7C8d2c7b4d085a4617853638a76d19b0da%7C1%7C0%7C638245964263457466%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=68k6CR6lvrlTfRoBbTr6HjCdilk4LJM6R0dpe5kmgTg%3D&reserved=0

Reporting Party — Reporting Party Information

B In this step, the reporter/user enters their own title, name, and contact information.

B Important Note: The contact information may be the same as the organization’s contact information.

Reporting party contact information:

|Tit|e“
|Fir!;t Mamea™ ||Last MName™ |
Telephone Mumber = Email *

Address Line 17

Address Line 2

City™ State™ Zip™

| || --Select-- VH
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Other Contact Information

Reporting Party — Person to First Learn Reporting Party — Point of Contact

B This step is optional and is B This step is optional and is
completed if the person who first completed if there is another person
learns of the incident is not the who should be contacted regarding
reporter/user. the incident.

Person to first learn of the incident if different than above: Point of contact to discuss incident if different than above:

Title |'I'itle

|Fir!;t Name Last Name First Name Last Name

| | | | | | |

Telephone Number Email Telephone Mumber Email

| | | | | | | |
IOWA
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Section 2: Provider Responsible for Member

B This is a new section to the critical incident reporting process that allows a
distinction to made between the organization that reports an incident and the
organization that as actually responsible for the member at the time of the
incident.

B Section 2 is completed when an incident occurs during a time that a provider
organization is responsible for the member.

B There may be situations when the provider organization responsible for the
member at the time of the incident is the same as the reporting party.

B There may be situations when there was no provider organization responsible
for the member at the time of the incident.
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Completing Section 2: Provider Responsible for Member

o mmmmmmmmm e m e e e e e — - = = I e i i}

' B If services were being provided at | | B If no services were being provided at '
the time the incident occurred, select : the time the incident occurred, select
Yes and enter the name of the service | | No.

Rrow::led n thg .tex.t ng“avall’a}ble . W If no services were being provided at
‘("'e" Day Habilitation”, ,,SCL’ ' the time the incident occurred, it is |
Supported Employment”) likely that no provider organization

was responsible for the member at
the time of the incident either. If that
is true, select the box next to this
statement as well.

Provider Responsible for Member at Time of Incident

1 |
1 |
: Were services being provided at the time of the incident?™ :
1 |

B yYes [INo

U No provider was responsible for member at the time of incident. (Skip to next |

1
Services being provided .
P section.) |
1
1

_____________________________________________________________________________________________________________________
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Completing Section 2: Provider Responsible
for Member (oncs)

A: If the responsible provider is same as
reporting party identified above and the

A O Responsible provider is the same as reporting party identified above. (Skip to corresponding box is checked...

next section.)

Automatic Action: Text fields in C will be
auto populated with the information that was
entered in the Reporting Party section.

B [No provider was responsible for member at the time of incident. (Skip to next
section.)

Attention: To find the provider responsible at the time of the incident, you can search by NPI er click on the
search icon for advanced options.

B: If no provider was responsible for member
at the time of incident and the corresponding
box is checked...

MNational Provider Identifier (MPI}™

Provider (Name or Agency) | . . ) . .
| B> i Automatic Action: Text fields in C will be

hidden. No information is required from the

Provider’s contact information: user.

Telephone Number Email

If neither checkboxes (A or B) are selected

Action Required: The reporter/user needs to
fill in NPI field or use the “Advanced Search”
(D) feature to search for provider which will
auto populate the remaining fields based on the
NPI. (More info on next page regarding
advanced search)
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Provider Responsible for Member —
Advanced Search

Advance Provider Search

i e g
e T —

T
Out of State

_!:FE

Search Clear Close

Step 1: Select if the provider is in IA or Out of
State. If “Out of State” is selected, need to select
the state as well.

i Step 2: Enter the name of the provider responsible. !
i Minimum: 3 characters. :

Step 3: Select the type of Provider. (Optional)
Step 4: Hit Search

Advance Provider Search

L rdor e T v
[ secoune R T
[T . r
- |
. e

Search Clear Close

Step 5: Once searched, if the search criteria
matches what we have in the system, a list of
providers will be populated as shown in the picture
in the right.

Step 6: Once you've found the provider, please
click on the “Select” button on the left which
should populate the provider responsible of
member field.

Currently showing 15 providers. Please select one OR refine search to continue.

NPI LPN Provider Name
Select @D | ACKLYN KAY SINNOTT

____________________________________________________ Select |—|— PATTIE KAYE JACKSON

Select _|— ATICIA MONIQUE JACKSON

Select __ JACKIE GILBERT

Select _- JACKSON MEDICAL SUPPLY

IOWA



Section 3: Medicaid Member

Step | Medicaid Member

Search Critera
’7"Medicaid State Identification (SID): : Search

Step 2
Medicaid State Identification {SID)™

First Name Last Mame

O || c—

Date of Birth Age Member's Gender

® ] Cviate @ remae
preferred Name: (S @0 |

Step 2.1 Date Incident Occurred™ Time Incident Occurred™

08/02/2023|

Mamber enrolled with:

________________________________________

B Step 1: Enter member’s state
Identification number (SID) and
hit search.

B Step 2: Fields in Step 2 will be
auto-populated based on the
member’s SID except for
“Preferred Name”.

B Step 2.1: Reporter needs to
enter the Date Incident
Occurred which will then auto
populate “Member enrolled
with” field with the assigned
MCO at the date it occurred.

Note:

A. “Preferred Name” — Enter name
if the member wishes to be called
with a different name.

B. “Member Enrolled With” — In
scenarios where the member was
not assigned or didn’t have an MCO
assigne Ket, the reporter will be
able to choose the correct MCO in
“Member enrolled with” field

C. Reporter will not be able to
access “Incident Description”
section (6) in navigation sidebar
until this section has been saved.
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Section 3: Medicaid Member (contq)

B [n this step, the reporter/user must
select at least one service from
which the member is enrolled from
the list.

Service Programs (select at least one)™
L] AIDS/HIV

() Brain Injury

[ children’s Mental Health

(I Elderly

[ Habilitation

B Only select the programs for which
i (I Health and Disability

. the member is currently enrolled.

. You may only select one waiver as a
. _member may only be enrolled on

. one waiver at a time. However, you
. may select one waiver in

i combination with Habilitation.

m If “TCM (Non-Waiver)” or “MFP” is
checked, all other service program
options will be disabled. It is a
mutually exclusive option.

[ 1Intellectual Disability
[ physical Disability
CImMFP

LJTCM [Non-waiver)




Section 4: Case Manager

A: If the case manager is same as reporting
party and the corresponding box is checked.

Automatic Action: Text fields in C will
auto populate with information that was
filled in Reporting Party — Reporting Party
Contact

Case Manager

A [Ocase Manager is the same as reporting party identified above.

B Select One™
[JMco cecm
[CJMFP Transition Specialist
[[JIHH Care Coordinator
[T other CM Entity

B: Select the type of case management
entity the member has from the available
options.

m  If “Other CM Entity” is checked, the

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

1

|

1

First Name ™ Last Mame ~ 3 9 o !
reporter/user must define “other” in the !
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

Case Manager contact information:

space provided. E.g. Targeted Case Manager
(]I)'CM)p. g g g

Telephone Number = Email *

| | | |
Address Line 17
| |

Address Line 2

4 other CM Entity [Other CM Entity Describe |

m  If “IHH Care Coordinator” is checked, the
reporter/user must write in the name of the
IHH program in the space provided.

EAIHH Care Coordinator |IHH Care Coordinator Describe |

|C't":': == v |Z'p” . | C: If checkbox A is not selected, the
| reporter/user must complete C.
i Action Required: User needs to fill
\ details of the case manager.
IOWA
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Section 5: Location of Incident and Withesses

Step I:

Step 2:

Step 3:

Location of Incident (select at least one)

Where did this incident occur?

[JMember's Home(Check all that apply)
[J community Location(Check all that apply)
[J other Location(Check all that apply)

Location of Incident (select at least one)

Where did this incident occur?

4 Member’'s Home(Check all that apply)

Member lives alone

[CIMember lives with family/relatives

[JMember lives with unrelated person or persons

[IMember lives in an RCF or Assisted Living Facility

[JMember lives in home that is owned/controllad by a service provider
[JMember is homeless

Cother

[J Community Location(Check all that apply)
[J other Location{Check all that apply)

Location/Facility Information

Location Mame

Address Line 1

Address Line 2

City State Zip

| || --Select-- v ||

Step 1: Select where the
incident occurred. Only
one location can be
selected.

Step 2: Select additional
descriptors related to the
location of the incident.

Step 3: Enter the location
information of where the
incident occurred.

IOWA
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Withesses

_______________________________________________________________________________________________________________________

. Enter the name and relationship of the witnesses present during the incident. If
. “other” is checked, the reporter/user must describe the relationship in the field

Witnesses and Others Present
Provide information about anybody present during the incident, including name, initials if 3 member, and the
persan’s relationship to the member. If other, specify.

Witness Name ﬁﬂaunzrll:irr Staff Family Housemate Other Other Describe

|Name | ] ] ] ] ] |Otf‘ er Describe |

|Name | ] ] ] ] ] |th" er Describe |

|Name | O O O J ] |th" er Describe |

|Name | ] ] ] ] ] |Dt|" er Describe |

|Name | ] ] ] ] ] |th" er Describe |
IOWA
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Section 6: Incident Description

B Date and Time Incident Occurred:
These fields are locked and can only be
changed through “Medicaid Member”
section, (3) in navigation side. In other
words, to change the info in this field to
go to section (3) - Medicaid member in
navigation sidebar, change and save it.

Incident Description

Date Incident Qccurred" Time Incident Occurred™
Date Incident Piscovered"

Description: =

(Include who, what, when, where, and how in a clear and concise manner noting the circumstances of the
incident.)

. m  Date Incident Discovered:
! The reporter/user is required to enter i
i the date the incident was discovered :
: using the date picker function. The ,
! system prevents the date the incident is

discovered to be before the date the
incident occurred.

Was the incident preventable?
[yves [wno  unknown
B Description: Use this section to

describe the incident per the instructions
in the application.

Root Cause ™
(Describe circumstances that may have led to or contributed to the incident.)

B Was the incident preventable:
Select from the available options.

B Root Cause: Use this section to
describe the root cause of the incident
per the instructions in the application.

IOWA
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Section 7: Incident Type

In this section, the reporter/user uses the available options to further describe the
type of incident that occurred, based on the definitions of a critical incident types.

IOWA
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Incident Type —
Physical Injury

_________________________________________

Step 1: Select this incident type
if the incident was an occurrence
resulting in physical injury
requiring physician/s treatment
or admission to a hospital.

Select the whether the physical
injury was to the member or by
the member.

Step 2: Select the kind of
physical injury.

Step 3: Select the cause of
physical injury.

Step 4: Select if the incident
resulted in medical intervention
or support services.

__________________________________________

Step | Physical Injury: Means an occurrence resulting in physical injury requiring physician’s treatment or
admission to a hospital.

Circumstances (select one)”
[Jphysical injury to member [ Physical injury by member

Step 2 Kind of Physical Injury {Check all that apply)~
1 Burn
) Fracture or break
[ Dislocation
[T Loss of consciousness
[l Concussion
| Poisoning or toxin ingestion
[ Bite (human or animal)
[] Adverse reaction to medication
[ Laceration
[ Puncture wound
[l other

Step 3 Cause of physical injury (check all that apply)*

CJuse of a restraint or physical intervention of any kind
[ assualt

I removal or failure to use a mobility aid

[ ntentional action by member

O self-harm

[CJunintentional action by member

[ physical aggression by member

[JIntentional action by staff or another person
I physical aggression to member
[Junintentional action by staff or another person
[ Accidental fall

[ Medication error

[ aspiration or choking

Clvehicular accident

Dother

Step 4 Did this incident result in? (check all that apply)™~
| Emergency room visit
) Admission to hospital
[JUrgent care visit
[ Treatment from emergency medical technician (EMT)
[ Consultation with poison control, an on-call medical professional, crisis line, or similar service.
Cn/a

25



°
I n C I d e nt I e — Step | Medication Error: Means occurrence that constitutes a madication error or pattern of medication errors
leading to physical injury, death, or emergency mental health treatment of the member.
L] L]
M e d I Catl O n E rr'o r' [/ Medication error by staff [ Medication error by member or another caregiver

Step 2 Kind of Medication error (check all that apply)™

[ I Wrong dosage

__________________________________________

Step 1: Select this incident type
if the incident was an occurrence
that constitutes a medication
error or pattern of medication
errors leading to physical injury,
death, or emergency mental
health treatment of the member.

[ Missed dose

) Wrong person

) Administration by unauthorized person
) Wrong medication

[ Intentional overdose

|_'Wrong route

[ Accidental overdose

[JWrong time

[ other

Step 3 cause of medication error (check all that apply)™
Select whether the medication () communication failure
error was by staff or by the

. member or member’s caregiver.

|| Documentation error

[Jintentional behavior by the member

|l Prescriber error

Step 2: Select the kind of
medication error.

[Jpharmacy error
Cother

Step 4 Did this incident result in? (check all that apply)*

Step 3: Select the cause of
medication error.

|/ Emergency room visit

) Admission to hospital

[_JUrgent care visit

[ Treatment from emergency medical technician (EMT)

[ Consultation with poison control, an on-call medical professional, crisis line, or similar service.
Cn/a

Step 4: Select if the incident
resulted in medical intervention
or support services.

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
|
1 —
1 |_Error by person administering medication
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
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Step |

Step 2

Step 3

Step 4

Incident Type — Emergency Mental Health Treatment

Emergency Mental Health Treatment: Means an occurrence requiring emergency mental health

treatment for the member.

Kind of Emergency mental health treatment (check all that apply)~

[CJ Crisis line or mobile crisis treatment for an emergency mental health crisis.

[l Use of an emergency restraint or physical intervention of any kind as a means of handling an emergency
mental health crisis.

|| Emergency room treatment for an emergency mental health crisis.

[l Intentional use of any medication to subdue, sedate, or restrain the member experiencing an emergency
mental health crisis.

[ Admission to the hospital, crisis bed or sub-acute mental health facility, or other mental health treatment
[ other

Cause of emergency mental health treatment (check all that apply)~

[JMember attempted suicide

[JMember expressad suicidal ideation
[JEscalating behavicral health concerns
[JEscalating mental health concerns

[J aggression by member

[J Medication error

[ Toxic effect of substances/adverse reaction to substance
[JTriggering event or other triggering factor
[ self-harm/self-injurious behavior
[Junknown

Cother

Did this incident result in? (check all that apply)™*

) Emergency room visit

[] Admission to hospital

[ Urgent care visit

) Treatment from emergency medical technician (EMT)

[_J Consultation with poison control, an on-call medical professional, crisis line, or similar service.
Cn/a

Step 1: Select this incident
type if the incident was an
occurrence requiring
emergency mental health
treatment for the member.

Step 2: Select the kind of
emergency mental health
treatment.

Step 3: Select the cause of
emergency mental health
treatment.

Step 4: Select if the incident
resulted in medical
intervention or support
services.
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Incident Type — Law Enforcement Intervention

Step | Law Enforcement Intervention: Means an occurrence that requires the intervention of law

enforcement.

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

[[JMember was a victim [JMember was a perpetrator

Was the member arrested?
Oyes Cine CIna

Was the member charged?
COyes Clne CIna

Kind of Law enforcement intervention (check all that apply)*

| Response to a medical/injury call

[ Response ta mental/behavioral health call

[ Response to a domestic disturbance

[JResponse to a crime in progress

['] Response to general report or call

I Welfare check

JUnknown

I Incarceration of any type (jail, prison)
Other

Cause of law enforcement intervention (check all that apply)™

) Member committed a crime/ was engaging in criminal activity

] A domestic disturbance occurred in the member’s home

L) Member was a victim of a crime

[ Member inappropriately contacted emergency numbers

[ Member exhibiting mental or behavioral health issues that put themselves in danger
) Member location was unknown

) Member exhibiting mental or behavioral health issues that put others in danger

LI Member was experiencing medical issues or physical injury

) other

Law Enforcement contacted?
Yes CINJA

Officer Name and Contact Information

Did this incident result in? (check all that apply)™

| Emergency room visit

| Admission to hospital

1 Urgent care visit

I Treatment from emergency medical technician (EMT)

CIN/A

1 Consultation with poison control, an on-call medical professional, crisis line, or similar service.

__________________________________________

Step 1: Select this incident type if
the incident was an occurrence
requiring law enforcement
intervention.

Step 2: Select if the member was
victim or Perpetrator. Not
required it member doesn’t fall in
either category. Reporter can skip
this question and move to step 3.

. Step 3: Indicate whether the
' member was arrested or charged
' or NA if the member was not the !
\ perpetrator.

Step 4: Select the kind of law
enforcement intervention.

Step 5: Select the cause of law
enforcement intervention.

Step 6: If law enforcement was
contacted, enter additional details.

Step 7: Select if the incident
resulted in medical intervention or
support services.

IOWA
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Incident Type — Abuse Report

Step | Abuse Report: Means an occurrence that requires a report of child abuse or dependent adult abuse.
Step 2 [ Member was a victim [/ Member was a perpetrator
[ Yy o Col e oo N I c 1
Step 3 Kind of Abuse report {check all that apply)* i Step 1.' SeIeCt thls InCIdent type If :
I Physical abuse of a dependent adult / nonaccidental physical injury of a child : the InCIdent was an Occurrence :
t .:irsigﬂg:jzengradation of a dependent adult/ Mental injury of a child : reqU|r|ng a report of Ch||d or' :
[ .Sefcual abuse : dependent adult abuse. :
[ .Self—denilal of critical care 1 . :
- Other child abuse type . Step 2: Select if the member was !
I Denial of critical care 1 N .
[ other ra victim or a perpetrator. |
, 1
Step 4 Cause of abuse report (check all that apply)~ | Step 3: Select the kind of abuse !
) Suspected abuse or neglect from staff : report. :
[) Suspected self-denial of critical care ' !
[ Suspected abuse or neglect from a family caregiver : Step 4: Select the cause of abuse :
O Unknown ' report 1
| Suspected abuse or neglect by member to another person : P ‘ :
- orher . Step 5: Select if abuse allegation
Ste 5 Was the abuse allegation founded?* : was fou nded * :
p [I¥es [ 1No [JUnknown [ ] Pending : :
. Step 6: Select the type of report |
step 6 HHS Abuse Report [ Departmgnt of Inspection, Appeals, and Licensing (DIAL) : that WaS SmeItted, 'Ol:lce Selected :
Date [ 1= . enter date filed and if it has been |
o e i E— ‘I | accepted. !
ccepte 1 .
1 . . . \
Step 7 Did this incident result in? {check all that apply)* : Ste? 7d: SeleCtd!f tP.e InCIdent-: :
LJEmergency room visit !
1 Admisgsian"m ool : resulted In m.e ical Iintervention or !
[ Urgent care visit 1 Su Pport SerVICeS. :
[ ] Treatment from emergency medical technician (EMT) : :
[ Consultation with poison control, an on-call medical professional, crisis line, or similar service. : 1
DN/A ! |
—
IOWA
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Step |

Step 2

Step 3

Step 4

Step 5

Incident Type — Location Unknown

Location Unknown: Means an occurrence that involves a member’s location being unknown by staff who

are assigned protective oversight.

Approximately how long was the member’s location unknown?*

Kind of Location unknown (check all that apply)™

) Member cannot be located or contacted during times when protective oversight should be provided
) Member left programming/services against court orders or professional advice
) Other

Cause of the location being unknown (check all that apply)™

[l Inadequate staffing to provide protective oversight to all members as outlined in their plans
[IMember plan did not adequately address protective oversight needs or supervision not previously
identified as a risk for the member.

[ 5taff not present when/where expected (i.e. did not arrive to work on time; left during shift; was
sleeping when sleeping is not permitted per agency policy or member need)

[C) 5taff not properly trained on member’s plan.

| Monitoring/Supervision technology failure (i.e. cell phone, GPS, overnight monitoring system)

[l An incident or triggering event occurred resulting in the member’s location being unknown.
[JRedirection, de-escalation, and/or monitering/supervision plan was unsuccessful to prevent the
incident.

[ Member not present when/where expected (i.e. did not return to protective oversight at an agreed
upon time)

[ Other

Did this incident result in? (check all that apply)*

[ Emergency room visit

] Admission to hospital

[ 1 Urgent care visit

[ Treatment from emergency medical technician (EMT)

[] Consultation with poison control, an on-call medical professional, crisis ling, or similar service.
CIN/A

__________________________________________

Step 1: Select this incident type
if the incident was an occurrence
involving a member’s location
being unknown by a staff who is
assigned protective oversight.

Step 2: Enter approximately
how long the member’s location
was unknown.

Step 3: Select the kind of
i location unknown. |

Step 4: Select the cause of the
member’s location unknown.

Step 5: Select if the incident
resulted in medical intervention
or support services.

IOWA
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Step |

Incident Type - Death

Death: Means an occurrence of any type (including illness) that results in the member’s death.

Step 2 Kind of Death (check all that apply)*
[ Accident or injury
[ Suicide

I Tliness

| Homicide

I Natural causes

J Unknown

| Other

Step 3 Cause of death (check all that apply)™

[Joning iliness or chronic health problem
CJHomicide

[ sudden or unexpected iliness or injury
[DMedication error

D other natural causes

CDJunknown

D suicide

Jother

step 4 Was the death unexpected?*
Cives O Mo

Was the death preventable?*
[yes [JNe [J Unknown

Was an autopsy requested? *
[es (I No [ Pending [ Unknown

Was an autopsy performed?”
[J¥es (1Mo [ Pending [/ Unknown

Did the member have a DNR order? *
[J¥es [JNo [ unknown
Step 5 Location where death occurred: *
[IMember's home
[J Community location
[ Hospital
Cother
‘Address Line 1 |
‘Address Line 2 |
City State Zip
\ \ --Select-- ]| -]

__________________________________________

Step 1: Select this incident type
if the incident was an occurrence
that resulted in the death of the

member.
Step 2: Select the kind death.

Step 3: Select the cause of
death.

death was unexpected,
preventable, if an autopsy was
requested/performed and if the
member had a DNR order.

Step 5: Select where the
location of death occurred and

. Step 4: Indicate whether the
enter the location information.

IOWA
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Incident Type — Use of a Restraint

Step |

Step 2

Step 3

Step 4

Step 5

Use of a Restraint: Means an occurrence involving the use of a restraint of any type.

Incident Type™*

) Authorized (meaning the use of the restraint is or was at the time of its use, authorized by the member or

the member’s representative and their IDT and justified in the member's person-centered plan)
[l Unauthorized

Kind of restraint (check all that apply)*

I Physical restraint, intervention, hold, or management technigue (any direct contact used to control acute,
episodic behavior which is intended to prevent, restrict, or subdue movement of the member's body, or part
of the body).

[CJ Chemical restraint (a medication administered to control behavior, restrict freedom of movement, or
sedate the member that is not a standard treatment for the member’s medical or psychiatric condition. This
does not include as needed medications that the member requests or self-administers as part of their
symptom management plan.)

[ Isolation or seclusion (involuntary confinement to any room or area where the member is physically
prevented from having contact with others, is not free to leave the room or area or believes they are not
free to leave.)

I Mechanical restraint (mechanical intervention that is used to control acute, episodic behavior and is a
device to prevent, restrict or subdue movement or function of the member’s body, or part of the body).

[l other

Cause of restraint (check all that apply)™

|_I Redirection, de-escalation or non-aversive technigues were unsuccessful to prevent the incident.

[] Aggression by the member to another person or property that could not be managed using non-aversive
methods.

[ Self-harm/self-injurious behavior that could not be managed using non-aversive methods.

[ Emergency mental health crisis that could not be managed using non-aversive methods.

[ Staff not properly trained on the member’s plan.

' Member's plan did not adequately address behavioral intervention techniques to prevent the incident.
[ Unknown

[ Other

Did this incident result in? {check all that apply)*
[ Emergency room visit

) Admission to hospital

[IUrgent care visit

[I Treatment from emergency medical technician (EMT)

[l Consultation with poison control, an on-call medical professional, crisis line, or similar service.
Cim/a

Step 1: Select this incident
type if the incident was an
occurrence involving user of
restraint of any type.

Step 2: Select the incident
type.

Step 3: Select the kind of
restraint.

Step 4: Select the cause of
restraint.

Step 5: Select if the incident
resulted in medical
intervention or support
services.

IOWA
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Incident Type — Medical Treatment

Step | Medical Treatment: Means an occurrence requiring medical treatment for the member.

Step 2 Kind of medical treatment (check all that apply):*

[ Emergency room treatment

[l Admission to a hospital

I Treatment from an emergency medical technician (EMT)
) Urgent care treatment

[ Other

Step 3 Cause of medical treatment {check all that apply):*

[ Previously known, long-term medical condition or issue.

) Previously unknown or new long-term medical condition or issue.
[) Acute medical condition or issue.

[ Physical injury

[ Unknown

|| other

Step 4 Did this incident result in? {(check all that apply)™
) Emergency room visit
| Admission to hospital
[ Urgent care visit
[ Treatment from emergency medical technician (EMT)
] Consultation with poison control, an on-call medical professional, crisis line, or similar service.

__________________________________________

Step 1: Select this incident
type if the incident was an
occurrence that required
medical treatment for the
member.

Step 2: Select the kind of
medical treatment.

Step 3: Select the cause of
medical treatment.

Step 4: Select if the incident
resulted in medical
intervention or support
services.

CIN/A
IOWA
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Section 8: Immediate Resolution

The reporter/user uses this section to
describe what was done immediately
following the incident of discovery of
the incident to ensure the member's
immediate safety and to initially
resolve the situation.

Immediate Resolution (Describe what was done immediately following the incident or discovery of the
incident to secure the member’s safety and resolve the incident.)

Describe:™

Important Note: The maximum
character limit in the free text fields is
255 characters. If additional supporting
information needs to be included,
please use the “Additional Follow-up
and Notes” section or attach the
supporting documents using the
“Upload Supporting Documents”
function. Reference the location of the
additional supporting information in
the free text field.

IOWA
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Section 9: Notifications

B If N/A is checked in any of these questions. no

Notifications . ) . / .
additional information is required.

Immediate Supervisor:

clate sup - B If the other option is checked, the reporter/user
4 notified of incident On/a

must enter the name of the person notified and

First Name Last Mame Date

| Il Il | & the date of the notification using the date picker
Guardian or Member: funCtion'

B notifiad of incident Cn/a . .

First Name Last Name Date B The question regarding contact by case manager
| | | |4 following an incident should be marked N/A

Case Manager: unless the reporter/user is also the case

B notified of incident On/a manager.

First Name Last Mame Date )

m  A:lf Yes is checked, the reporter/user
must enter the date and approximate time
of the contact with the member from the
date picker and drop-down options.

A: If you are the case manager and you are reporting this incident:
Did you contact the member within 24 hours of learning of the incident?

Bves Cne Cnya
ate™ A Time .
pater[ [Hrimel ] ®  B:If No is checked, the reporter/user
must enter the date and approximate time
of the contact with the member from the
date picker and drop-down options.

B: If you are the case manager and you are reporting this incident:
Did you contact the member within 24 hours of learning of the incident?

Oves Eno Cnya
[ If N/A is checked, no further information
is required.

| | | @

Date™ | |jﬁ Time | v

IOWA
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Section | |: Remediations

Long-Term Remediation and Resolution

This was an isolated incident, and no long-term resolution is necessary. (Describe how the
incident was isolated and not likely to reoccur.)

Describe:

—————————————————————————————————————————————————————————————————————————————————————————————————

B Indicate where this was an isolated incident if this incident is unlikely to
reoccur.

B Describe what makes the incident isolated and unlikely to reoccur.

IOWA
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Remediations

B Select all the types of resolution that
will or have been completed to prevent
future, similar incidents from happening.

' m More than one type of remediation may |
| be selected. :
. @ Select whether the remediation has
i been initiated or completed. |

B Describe the remediation efforts.

Staffing-Related Remediation (Complete this section if remediation efforts include review and changes
in staffing, education, training, discipline, or reassignment of staff. Fully describe the action taken or
corrective action plans.)

Member-Related Remediation (Complete this section if remediation efforts include review and changes
to the member’s person-centered plan, behavioral intervention plans, crisis plans or other related plans or if
the member’s health or care needs will be reviewed or revised.)

[ 1nitiated CJcompleted

Was the member’s plan revised?

[es [ne

Describe:

Equipment and Supplies Remediation (Complete this section if remediation efforts include the
assessment, purchase or repair of equipment or supplies.)

[ Initiated [Jcompleted [ 1nitiated [Jcompleted
Describe: Describe:
4 4

HHS
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Remediations

Environment Remediation(Complete this section if remediation efforts include the evaluation,
accommodation, or modification of the member's environment or the environment where the incident
occurred to ensure safety or accessibility needs are met.)

Systemic Remediation(Complete this section if remediation efforts include systemic review and changes
such as updates to policies and procedures, training or retraining, guality improvement planning, or any
other agency-wide action taken to prevent or diminish the possibility of future incidents.)

[ 1nitiated [Jcompleted
[1nitiated O completed
Self-corrective action plan initiated?
Describe: Hves Lo

Describe:

IOWA
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Additional Follow Up and Notes

Additional Follow-up and Notes (Use the section to add any additional information about the incident

including follow-up that occurred, or updates to remediation and resolution.)

View additional Follow-up and Notes

Added by Ashish Upreti on 6/12/2023 10:27:27 AM:
Second MNote

Added by Ashish Upreti on 6/12/2023 10:27:16 AM:

Any additional notes added will be shown here along with user who entered and date time.

New additional Follow-up and Notes

Add Notes

Clear

_______________________________________

B Use the section to add
any additional
information about the
incident including follow-
up that occurred, or
updates to remediation
and resolution.

®  Any notes added will be
displayed like the picture
on the left. Each note
added will show who
submitted it and when.

IOWA
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Upload Supporting Documents

B Any supporting document can
be uploaded using the Upload
Supporting Documents
function.

Upload Documents:

Please select file of the following types: .pdf,.doc,.docx,.jpg,.jpeg,.bmp,.gif,.png,.xls,.xlsx, .txt
*Select a File: | Choose File | No file chosen

1
1
1
1
1
1
1
1
1
1
1
1
1
Upload :
1
1
1
1
1
1
1
1
1
1
1
1
1
1

B All uploaded documents for

seleet | Delote i = Dorsa 2055 om:30107 this incident will be available
Select | Delete [1949.pdf |BiniThatta |06/14/2023 08:29:52
for users to access through
this section/page.
IOWA
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Correction

This section outlines the correction process for incidents, detailing the steps
involved for both QA Specialists and Reporters. Consists of workflow, step-by-

step instructions, and automated notifications associated with the correction
process.

IOWA
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Things to keep in mind (Correction)

B There are some sections that cannot be corrected including:
m Reporting Party
® Medicaid Member

*If a mistake is made in the reporting party or member section, the incident

must be deleted and re-entered with the correct reporting party’s or
member’s information.

B Only reporters from the reporting organization can take actions to
the correction.

B The QA Specialist can cancel a correction request for an incident

only if the incident hasn’t been changed since the original request for
correction was made.

IOWA
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Navigation to the Correction Section

When an existing incident is opened, the Correction section can be found at the
end of the navigation bar under “Additional Information Section”.

Additional Information Section

Additional Fnllow—up and Notes v

Corrections

* indicates required
Complete in sequential order

IOWA
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Correction Status Process Flow

Step 1: QA Specialist requests a correction.

. Step 2: Reporter resolves the correction.

QA Specialist E> Reporter Reviews and E> QA Specialist Decides:
Requests Correction Resolves Correction Accepted or Rejected

If Rejected

IOWA
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Add Correction (QA Specialist)

Context: To initiate a correction request, the QA specialist selects the “Add Correction” link to request one to

the reporter.

1.  Click on “Add Correction” —a
pop-up box will appear.

2. In the pop-up, enter the
sections requiring correction.
This is an auto-populating text
box that displays eligible
sections based on characters
entered.

3. Provide a correction description
(maximum limit: 10,000
characters).

4. (Optional) Update the
reporter’s email if a different
reporter needs to review the
correction.

5. Click on “Submit”.

What Happens After Submitting?

! |
1 1
1 1
i 1. A new correction entry is added i
i to the Correction Table as !
! “Requested”. |
! |
I I
I 1
! |
1 1

1

2. Automated emails are sent to the
reporter responsible to the
correction.

Corrections:

Add Correction

|No corrections found for this incident.

Add Correction

Correction Section(s):*

Description:*

Close

Incident Td AP
Member Name: (I

Begin typing and selection will appear for selection.

Character limit: 10000 max.

feporter Emall:” o —— Bz oz

Submit Clear

45



Resolve Correction (Reporter)

1. In IMPA, open the CIR with the
requested correction.

2. Navigate to the Correction
Section.

3. Click on “View” to open a pop-
up with correction details.

4. Make the necessary changes to
the incident.

5. Once“chan es are confirmed,
click “Resolve”.

What Happens After Resolving?

1. Correction status is changed to
“Resolved”.

2. Email is sent to QA Specialist for
review.

Context: When a correction is requested, an email notification is sent to the assigned Reporter,
requesting them to review and resolve it.

Before Change |14 Requested |Incident Description View| |Resolve History
Close

Correction 1D: 14
Incident 1d - (D
Member Name : (N

Correction Section(s):™ | [ncident Description

Dascription:*r

Resolve Correction

Correction ID: 14 Incident Id: (D Member Name: (D

Correction Requested: Incident Description

Correction Made:

Do you really want to resolve this Correction?

OK Cancel




Accept & Reject Correction (QA Specialist)

Context: Once a correction is resolved, an email is sent to the assigned QA Specialist for verification.
Based on the review, the QA Specialist can accept or reject the correction.

2. Choose to Accept or Reject the correction.

i 1. In the Correction Table, click “Verify” to open a pop-up. Navigate to the Correction Section. i

________________________________________

What Happens After Accepting?

1 1
I 1
1 1
1 1
' 1. Correction status updates to i
! “Completed”. |
| |
| |
1 1
1 1
1 1
1 1

2. An email notification is sent to the
Reporter confirming completion.

Correction ID/E Incident Id: G Member Name: (D

Correction Requested: Incident Type - Death

Correction Made:

What Happens After Rejecting?

“Change Status: () Accept ) Reject

Comment: | M ximum limit: 500 characters

1. Correction status updates to
“Needs Review”.

2.  An email notification is sent to the
Reporter requesting further
review.

Submit Clear

IOWA
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Cancel Correction (QA Specialist)

Context: If a requested correction is no longer needed, the QA Specialist can cancel it. However,
. cancellation is only allowed when the correction status is “Requested”. If the Reporter has already
' accessed and made changes, cancellation will not be available.

1. In the Correction Table, click
“Cancel”.

i 2. Enter cancel reason. Max
i character limit: 500.
i 3.  Once confirmed, click on “Ok”

button to cancel the correction
request.

What Happens After Cancelling?

1. The correction status updates to
“Cancelled”.

2. An email is sent to the Reporter,
notifying them that the
correction has been cancelled.

Corrections:

Correction
ID Status

Before Change|38 Regquested|Incident Description

Cancel Correction

Correction ID: @@ Incident Id: (EEEE® Member Name: (D

Do you really want to cancel this Correction?

“Cancel Reason: |\ aximum limit: 500 characters

OK Cancel

48



Correction History Table

Context: Correction history table maintains a detailed log of all activities related to the correction. Each
correction has a history log tracking changes, including:

1. Status updates (Requested, Resolved, Needs Review, Completed, Cancelled)

2. QA Specialist and Reporter assignments

_______________________________________________________________________________________________________________________

Activity Date v QA Spedalist Email Reporter Email
4/2/2025 12:37:16 PM__ |Completed
4/2/2025 12:38:21 PM__ |Resolved

QA Specialist
4/2/2025 12:35:43 PM_ |Reassigned
4/2/2025 12:35:28 PM__ |Needs Review
QA Specialist
4/2/2025 12:34:35 PM  |Reassigned
4/2/2025 12:35:46 PM__ |Resolved
4/2/2025 12:33:45 PM__ |Requested

Reject

Tracked Columns:
1. Activity Date: When the action occurred.

2. Activity Type: Status or user assignment changes.
QA Specialist Email: Assigned QA Specialist at the time of the activity.

4
5. Reporter Email: Assigned Reporter at the time of the activity.
6

3, Activity By: User who made the change. i
i Comments: Entered by QA Specialist when accepting or rejecting a correction. i

_______________________________________________________________________________________________________________________

HHS .




Automated Emails (Reporter)

_______________________________________________________________________________________________________________________

Context: To keep users informed and ensure timely resolutions of corrections, automated emails
are triggered at certain stages of the process.

Email Subject Email Trigger

Correction Requested A new correction has been requested.

Correction Needs Review Correction was rejected and requires
further review.

Correction Accepted Correction has been accepted.

New Reporter Assigned A new reporter has been assigned to the
correction.

Correction Cancelled The correction request was cancelled by

the QA Specialist.

Unresolved Correction Overdue  |5%,20%, and 25 day reminders if
unresolved.

IOWA
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Automated Emails (QA Specialist)

_______________________________________________________________________________________________________________________

Context: To keep users informed and ensure timely resolutions of corrections, automated emails
are triggered at certain stages of the process.

Email Subject Email Trigger

Correction Resolved Reporter has resolved the correction.

New QA Specialist Assigned A new QA Specialist has been assigned
to the correction.

Unresolved Correction Overdue (Copy) Copy of emails that were sent to
reporters when was unresolved for 15,
20, and 25 days.

IOWA
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Existing Incidents

The “Existing Incident” function allows organizations to access all incidents
submitted by IMPA users of the organization/provider group.

IOWA
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Existing Incident Page

—Search

Incident Status:

Incident Number:

|
2
3

I

Medicaid State ID:

Incidents Created From: |04/10/2020 ] Incidents Created Until: |04/10/2025 ] 6

Find Reset

Exporttocsv 7

Incident Incident

Medicaid Member Occurred Created
Incident ID State ID Member Name Enroliment Date Reporter Name  Case Manager Name Case Manager Type Date Primary Incident Type  Incident Status Note

Select 18975 [ ] 03/01/2025 (D MCO CBCM 03/05/2025 | Physical Injury Corraction Report
Select 18974 Not Available | Not Available Not Available 03/04/2025 | Not Available Initial Submission
Select 18973 ——— 03/03/2025 NS  —— MCO CBCM 03/04/2025 | Physical Injury Corraction Report
Select =9 18972 _ _ Molina 02/26/2025 b _ MFP Transition Specialist| 02/27/2025 | Medication Error Final Submission
Select =p| 18971 _ |_ Wellpoint 02/26/2025 |— _ MCO CBCM 02/27/2025 | Physical Injury Initial Submission
Select =9 | 18970 _ _ Wellpoint 02/26/2025 _ _ MCO CBCM 02/27/2025 | Physical Injury Initial Submission

8 9 10 Il 12 13 14 15 ) 17 18 19 20

_____________________________________ 1 e | P |

Legend 8. Select — View critical incident 16. Case Manager Name — Name of the case manager

1. Status — Can search for “Submitted” or

ear 9. Print — Will generate pdf of the critical incident.
“Completed” incidents

Only displayed once incident is submitted.

17. Case Manager Type — Shows the type of case
manager.

2. Incident Number — Incident ID (Unique Key)
3. Medicaid State ID — Medicaid State ID

! !

! 1

! 1

! 1

! 1

' i

1

10. Incident ID — Critical Incident ID/Number | 18. Incident Created Date — Date of when the incident '

| was created in IMPA application. I

11. Medicaid State ID — Medicaid State ID I '

4. Consumer Last Name — Member’s Last Name | 19. Primary Incident Type — Show the primary incident !
't f the Cl t.

5. Reporter Last Name — Reporter’s Last Name ' 7pe ol the &1 repor :

13. Member Enrollment — Who the member is ' |

1

! !

! 1

! 1

! 1

! 1

! 1

! 1

' 1

| 1

enrolled with.

20. Incident Status— Initial Submission or Final

6. Incident Created From/Until — Incidents within o ;
Submission or Correction Report

the date range. (Default set to 5 years, can access
up to 40 years of data)

14. Incident Occurred Date — Date Critical Incident
occurred to member. If not completed, date won’t be
available.

7. Export to CSV — Will export all incidents
currently showing in the existing incidents table
based on the search criteria.

1
1
1
1
1
1
1
1
1
1
1
1
|
1
! 12. Member Name — Member’s Full Name
1
1
1
1
1
1
1
1
1
1
1
1
1
1

15. Reporter Name — Name of the incident reporter
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